Unit 1 — Vector - lllustrator Guide

How to download fonts (Mac os)

Choose a font from your favorite font site.

Unzip the file from your downloads folder.

Then go to your Applications Folder to your “Font Book”

Drag your Font file (.ttf or .otf) into the list of Fonts in the Font Book

Under Windows 8/7/Vista
Select the font files (.ttf, .otf or .fon) then Right-click > Install

Open lllustrator — Brown/Orange “Ai” Adobe Icon

Open a new document
File> New or 3N

New Document

MName:
Profile; [Custom]

Number of Artboards: & [

:| 800 x 600
Units: Pixels

Orientation: [

Left

* Advanced
Color Mode:
Raster Effects: Screen (72 ppi) v

Preview Mode: Default v

+ Align New Objects to Pixel Grid

Templates... Cancel
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Name your Document

Profile: Web

Size: 800 x 600

Orientation: Horizontal or Vertical
Click ok.

You can Modify the sizes for inches If needed, until “units” you can choose
inches, pixels etc

Hllustrator File Edit Object Type Select Effect View Window Help
B mEr
Characters l:' v . v Stroke

Up top you have lllustrator, File, Edit, Object, Type, Select, Effect, View,
Window, and Help.

File: New, Open, Save, Close, and Print

Edit: Undo, Redo, Cut, Copy, and Paste

Object: This includes everything about your Pen tool and Shapes. The
Transformation, Arrange, Expand, ETC

Type: More Information on your Type, Includes a better look at your Fonts
Select: Groups things together, easy for moving from one artboard to another
artboard.

Effect: Think like Filters in Photoshop Play Around with These!

View: Zoom In/Out

Window: Brings open things you may need on your workspace, if you cannot
find something, look in here

Help: Just use Google

Tool Bar Explained
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Tools panel overview

® Indicates default tool
* Keyboard shortcuts appear in parenthesis

o Selection tools
s R Selection (V)

] [} Direct Selection (A)
Is* Group Selection

=% MagicWand (V)

#¢R? Lasso (Q)
5.7 Artboard (Shift +0)

e Drawing tools

= Pen (P)
"p Add Anchor Point (+)
é? Egl_lstte Anchor (-}
Convert Anchor
Point {Shift+C)
® / Line Segment (\)
 Arc
@ Spiral
B8 Rectangular Grid
& PpolarGrid

u[@ Rectangle (M)
@ Rounded Rectangle
@ Ellipse (L)
@ Polygon
¥ Star
L Flare
=/ Pencil (N)
4 Smooth
& Path Eraser

u[} Perspective Grid (Shift+P)

Perspective Selection
. (Shift+V)

@ Type tools

5T Type (T)
Area Type
~¢" Type On a Path

T Vertical Type

|7 Vertical Area
Type
&, Vertical Type
~ On a Path

@ Painting tools
u_/ Paintbrush (B)
u[# Blob Brush (Shift+B)
mE3 Mesh (U)
8] Gradient (G}
= # Eyedropper (I)
&3 Measure
@ Live Paint Bucket (K)

@ Live Paint Selection
(Shift+L)

© Reshaping tools

= ¥ Rotate (R)
{74 Reflect (O)

= {7 Scale (S)
Z7 Shear
¥ Reshape
= % Width (Shift+W)
14 Warp (Shift-R)
(G Twirl
'm' Pucker
> Bloat
[& Scallop
'3:11 Crystallize
"] Wrinkle

=K} Free Transform (E)

IQ Shape Builder (Shift+M)

uldp Blend (W)

@ Ssymbol tools
"B Symbol Sprayer
(Shift+5)
¥ symbol Shifter
®e Symbol Scruncher
@ Symbol Sizer
4@* Symbol Spinner
&g Symbol Stainer
@9 Symbol Screener
@ symbol Styler

® Graph tools

u 4]} Column Graph (J)

|21 Stacked Column
Graph

B BarGraph

» Stacked Bar
B Graph

B Line Graph
[~ Area Graph
|- Scatter Graph
0 Pie Graph

@ Radar Graph

@ slicing and cutting
tools
u _F Slice (Shift+K)
E¥ slice Select
u @ Eraser (Shift+E)
> Scissors (C)
& Knife

@ Moving and zooming

tools

= <" Hand (H)
I} Print Tiling

] QZDDI‘I‘I (Z)

Placing Text on your Artboard
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o
Click on the Text icon and drag the blue box on your art board.

Type what ever your “Logo” name is for work.

Samantha Lyn Aasen|

Up top you can choose your Font, Font Weight, and Size of your text.

v Myriad Pro

ogo* @ 136% (RGB/Pre
Myriad Web Pro

MNeou
Mews Gothic MT
Motewaorthy

Mueva 5td

Play around with various fonts and sizes. **remember that Vector graphics in the
Al file are scalable™

SAUANTRA LYN RAS]

Once you have settled on your decided font and text size, you may want to “jazz
it up”

Warp Tool
The icon for the warped tool is up above is near your settings for Text

Click on it you get the tools to warp the text.
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Warp Options

Style: % Arc v

+ Horizontal Vertical
Bend:
Distortion

Horizontal:

Vertical:

Preview Cancel

You may want to check “Preview” to see how you are adjusting all the
parameters. From various styles, Horizontal / Vertical, Bend etc. there are
unlimited ways to use this function.

-

Playing with Individual Letters

You may want to try “ungrouping” your text to give each Letter it’s own special
treatment. This takes the one object of all your words into separate objects.
Press “V” to Select your all of your Text. Then go to Type> Create Outlines
Then, make sure all of your text highlighted. And Press “Shift-Ctrl-G”

Samantha Tun fasen

Your Text will look like this and your layers board will look like:
Layers

. Layer 2

v = Layer 1

| l <Com...

[ﬂ <Com...

[j.! <Com...
s
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You can Zoom in and treat each object like “PATHS” and use the Pen tool.

Changing Font Color

Once you have decided on the warp you may want to try out other color
combinations. Highlight your text or 3£A Then on the left of your Text
settings you click on this icon.

here are some of your color swatches, which you can always add too if you find
yourself using a specific color multiple times in Illustrator.

To adjust a color click on the second icon (to the left of the folder)

Which brings down a new drop box to adjust colors.
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Swatch Options

Here you can adjust the
Tint of your color, and
Swatch Name: S CFXOE T N other variables to get the

Color Type: Process Color correct hue_ you desire.
Be sure to check the
“preview” box to see
Color Mode: RGB exactly what you are
adjusting.

Glabal

Cancel

There are many to change text color in lllustrator, check this
tutorial out:

http://www.wikihow.com/Change-Adobe-lllustrator-Font-Color

Adding Other Shapes or Banners

[, = [ Rectangle Tool (M You can use the shaped lllustrator

@ Rounded Rectangle Tool Provides, or draw while using the Pen
@ Ellipse Tool L Tool. Make Sure you draw the new object

k

@ Polygon Tool on your layers panel behind your text.

7% Star Tool

(®" Flare Tool

Then you can use the same effect under EFFECTS.

Other Text Options
On the tool bar if you click and hold down on the text icon L
A new dialogue box opens with more options.

k
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= T Type Tool You can place text on a Path
(remember the Powerpoint) to make
¥ Area Type Tool a very different orientations for your

~«"* Type on a Path Tool text, allowing even limitless
_ opportunities for the Logo. | will
IT vertical Type Tool show “Type on a Path Tool” for this
tutorial, feel free to pl ith all of
1S¥ vertical Area Type Tool ﬂ'“: ;{; e f: ol SI'EE © play with alto

~% vertical Type on a Path Tool

Type on a Path Tool (Text)
You must begin with a Path, which you create with a pen tool.
Here is a quick explanation of the pen tool from Adobe.com

¢4 d N

Pen Subtract Convert
Tool An r:hc-r Anchor  Anchor
Point Point Point

ORI

Place Close Begin  Convert
1st Point  Path Work on End

of Object Deselected Point
Path

Different styles of the pen tools
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E C i
|
; %
.,f' E

Components of a path

A. Selected (solid) endpoint B. Selected anchor point C. Unselected anchor
point D. Curved path segment E. Direction line F. Direction point

AR

Points on a path

A. Four corner points B. Four smooth points C. Combination of corner and
smooth points

For more information with Pen drawing see:
http://help.adobe.com/en_US/illustrator/cs/using/WS714a382cdf7d304e7e07d0

100196¢cbc5f-6269a.html
http://sites.duke.edu/oit-mps/2012/04/29/introduction-to-the-pen-tool-in-illustra

tor/

Drawing with the pen tool takes a lot of practice. Think about plotting points on
the X&Y axis as the anchor points
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The shape tools can also help with simple shapes like circles and rectangles.
Drawing your Path

Using my pen tool | made sure to have no color, so | do not have part of my
“text on path” a partial full shape.

M- Ei-

Then | began drawing my shape, take your time, and it will take many attempts.

Here is my path, then | go to my text tool and choose “Type on a Path tool”

After playing around with spacing, | come to this final one.

For more text on path help check Adobe’s website.
http://help.adobe.com/en_US/illustrator/cs/using/WS714a382cdf7d304e7e07d0
100196¢cbc5f-63eda.html

Saving and Exporting

Make sure to save your file as a “.ai” file often. This will save you from crashes.

Your .ai file will be only reable in Adobe, saving all of what makes it a vector
based file.
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You export for finals, or view for web.
File>Export and a new screen will appear

e ] Export
Save As: AasenlLogo.png |E|
Tags:
Where: | [ idmspring2014 =2
Format: | PNG (png) 3
| | Use Artboards ) All Range: 1
| Cancel | [ Export ]

You can choose PNG for the purpose of this class, but note it is a large file. You
may want to export for .jpg or even .gif when you use for web or print.

PNG Options
You can up the resolution or

Options DPI, but 72 is recommend
for web or screen viewing.

Resolution: S5creen (72 ppi) -
You can have a transparent,
Anti-aliasing: ' Type Optimized (Hinted) i white or black background,
e isrlaced '.ES it was not predetermined
in llustrator.

Preview

Background Color: White

SREARTIN Yyggg,
LR )

Intro to Digital Media — Vector - Aasen



AREARRLIRITTEYS

Here is my Final logo.

You can be as creative. What is mentioned in this guide is a bare minimum,

there are thousands of Adobe lllustrator Tutorials on the web. Adobe’s is

excellent, and great for beginners.
https://helpx.adobe.com/illustrator/topics.html

YouTube is a great resource, allowing you to see how things are done.
http://www.youtube.com/user/goodcreativetutorial/videos
http://www.youtube.com/results?search_query=illustrator%20tutorial&sm

=1

Other great resources
http://www.tutorialized.com/tutorials/lllustrator/Text-Effects/1
http://vector.tutsplus.com/

Lastly “Lynda.com” which is a paid access website, but | have used it in the
past, and it is one of the best tutorials | have found for all of Adobe suite.

Creating an Amazing Logo Tips
http://design.tutsplus.com/articles/the-process-of-designing-a-killer-logo--vecto
r-181

Comprehensive Intro to Text in lllustrator
http://design.tutsplus.com/tutorials/illustrators-type-tool-a-comprehensive-intro
duction--vector-521

Character Panel in Adobe lllustrator
http://design.tutsplus.com/tutorials/quick-tip-the-character-panel-in-adobe-illus
trator--vector-10368

Working with Type on a Path in lllustrator
http://design.tutsplus.com/tutorials/working-with-type-on-a-path-in-illustrator--c
ms-20711

Text Improvements with Adobe lllustrator CC
http://design.tutsplus.com/tutorials/whats-new-with-adobe-illustrator-cc-text-im
provements--vector-13510

Creating Banners in lllustrator
http://design.tutsplus.com/tutorials/how-to-create-banner-label-and-badge-tem
plates-in-illustrator--cms-19971

More Banners
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http://design.tutsplus.com/tutorials/quick-tip-how-to-create-a-simple-banner--v
ector-4409

Scanning and Creating 3D Text
http://design.tutsplus.com/tutorials/create-a-variety-of-3d-lettering-effects-for-p
oster-design--vector-4305

Giving Design extra style with Alternate Characters
http://design.tutsplus.com/articles/give-your-design-extra-style-with-alternate-c
haracters--cms-19732

Brand Identity
http://design.tutsplus.com/tutorials/quick-tip-how-to-create-a-clear-and-concis
e-brand-identity-guide--vector-5990

Creating Logos in Photoshop V. lllustrator
http://design.tutsplus.com/tutorials/comparing-the-logo-creation-process-betw
een-adobe-photoshop-and-illustrator--cms-21380

3D Retro Text
http://design.tutsplus.com/tutorials/quick-tip-create-a-3d-retro-text-effect-with-
the-appearance-panel--vector-18656

Trend Nautical Text Theme
http://design.tutsplus.com/tutorials/create-on-trend-flat-type-with-a-nautical-the
me-in-adobe-illustrator--vector-11670

3D glasses Text
http://design.tutsplus.com/tutorials/how-to-create-an-anaglyphic-text-effect-in-
adobe-illustrator--vector-18526

Glitter Text
http://design.tutsplus.com/tutorials/how-to-create-a-vector-glitter-text-art-effect
--vector-6133

Retro Flyer
http://design.tutsplus.com/tutorials/vintage-vector-design-workflow-creating-a-r
etro-flyer-design--vector-5520

Knitted Text
http://design.tutsplus.com/tutorials/create-a-christmas-knitted-text-effect-in-ad
obe-illustrator--vector-19778

Nail Polish Text Effect
http://design.tutsplus.com/tutorials/create-a-fabulous-nail-polish-text-effect-in-
adobe-illustrator--cms-19998

Chalk Text Effect using the Pen Tool
http://design.tutsplus.com/tutorials/create-a-chalkboard-effect-with-the-new-pe
n-tool-in-illustrator--cms-21508

3D grungy Text
http://design.tutsplus.com/tutorials/create-a-3d-grungy-text-effect-in-illustrator-
-vector-5024

Fun Stroke and Shadow on Text
http://design.tutsplus.com/tutorials/quick-tip-applying-a-gradient-outline-and-p
erspective-shadow-to-live-text-in-illustrator--vector-4780

Text Mask in Adobe lllustrator
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http://design.tutsplus.com/articles/quick-tip-how-to-make-a-text-mask-in-adob
e-illustrator--vector-4218

3d Glossy Text
http://design.tutsplus.com/tutorials/create-super-glossy-3d-typography-in-illustr
ator-and-photoshop--psd-11196
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